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 Welcome...
Welcome...

Welcome to the user guide for the desk phones Mitel 6863 SIP and 
Mitel 6865 SIP for MiVoice Office 400 communication systems.

This user's guide will assist you with the use of your phone and introduce 
you step by step to the functions and configuration. If you require further 
technical support or information on other products of Mitel, please visit our 
website www.mitel.com, use our Mitel DocFinder or find the document on 
Mitel eDocs.

This user's guide is relevant only for Mitel SIP phones connected to a 
MiVoice Office 400 communication system. Other user’s guides are avail-
able for operation on other communication systems or for direct operation 
via a SIP provider. Consult your system administrator if you are unsure 
whether you have the correct user’s guide for your requirements.

Notes: • Not all listed functions are available by default. Contact your system 
administrator to learn more about the available features and services in 
the MiVoice Office 400 communication system.

• Your system administrator has the option to individually set some of the 
phone's features. In this case your default values will differ from the 
default values described in this user's guide.

• Some functions are offered both from the MiVoice Office 400 communi-
cation system and locally from your Mitel SIP phone. Since the MiVoice 
Office 400 communication system does not fully support local functions, 
we recommend you to always have your system administrator do the 
configuration work or use the Self Service Portal yourself (see chapter 
"MiVoice Office 400 Self Service Portal", page 9).
Mitel 6863 SIP / Mitel 6865 SIP 3
eud-1663/2.0 – R6.0 – 06.2018

http://www.mitel.com
http://www.mitel.com/docfinder
http://edocs.mitel.com/UG/Index.html


 Welcome...
Safety information

Failure to observe this information can be hazardous and infringe existing 
laws.

Connections
Always plug the phone cable connectors into the appropriate sockets. Do not 
modify the connections in any way.

Power supply
Your phone can be supplied with power in various ways. Pay attention to the 
information given by the system administrator. 

Note: The device will be inoperable when the mains power for the communication sys-
tem fails.

Metal objects
Telephone receivers produce magnetic fields that can attract small metallic 
objects such as pins and staples. To avoid injury, do not place the handset 
where such objects can be picked up.

Maintenance

• Make sure all installation and repair work is carried out by a specially qualified 
technician.

• Always use a soft, moistened, or anti static cloth to clean your device. Do not 
use chemicals or other chemical products.

Cost control and data protection
You should protect your phone with a PIN so that no-one can make phone calls 
at your expense. A code will also protect your personal settings.

Ambient conditions

• Only operate the device in a temperature range of +5 °C to approx. +40 °C.

• Avoid direct sunlight and other sources of heat.

• Protect your device against the moisture, excessive dust, corrosive liquids 
and steam.

• Do not expose your device to electromagnetic fields (for example: electric 
motors, household appliances). The speech quality could be affected.

Disposal
Be sure to dispose of your device, batteries and its packaging in an environmen-
tally compatible way. Electrical equipment does not belong in domestic waste. 
Deposit it at a return center.

Accessories
Use original accessories or specifically approved accessories only. The use of 
other accessories may decrease performance or pose a risk to your health or 
safety.
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Document information
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 Information about the MiVoice Office 400 communication system
Information about the MiVoice 
Office 400 communication system

One number user concept
Your system administrator can set up several phones for you, all of which 
have the same phone number (one number user concept). You have only 
one name and phone number with which to identify yourself to your call 
partners, regardless of which of the phones you use to make your calls. 
The advantage is that callers can reach you by using the same phone 
number, wherever you happen to be.

With personal call routing, you can define to which phone (or phones) 
incoming calls must be routed (see the chapter "Activating personal call 
routing", page 50).

Some of the benefits of the one number user concept are:

• With Ring Alone, you can choose on which phone calls are signaled 
acoustically (see chapter "Activating Ring Alone", page 51).

• Your system administrator can set whether you are busy for further 
incoming calls (indicate to the caller that you are busy if you are on 
another call).

• You can make outgoing calls using the other terminals while you are 
already on a call.

• Call lists and contacts stored on the MiVoice Office 400 communication 
system are available on all your phones and are automatically synchro-
nized.

• An announcement is made on all phones that support announcements.

• Fast Take (*88) allows you to receive an incoming call on any of the 
phones while you are already on a call on another phone.
8 Mitel 6863 SIP / Mitel 6865 SIP
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MiVoice Office 400 Self Service Portal
The Self Service Portal is a web-based application for phones on a 
MiVoice Office 400 communication system. The Self Service Portal helps 
you configure and modify your personal phone settings (for example: key 
configurations, labels for configurable keys, display language, and so on) 
directly and autonomously using your PC.

After you receive your user account details for the Self Service Portal from 
your system administrator and after you log on to the portal, the home 
page displays an overview of all your phones. See the Self Service Portal 
online help for further information about specific topics.

Contact your system administrator for the credentials for access to the Self 
Service Portal.
Mitel 6863 SIP / Mitel 6865 SIP 9
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 Keys, display, and menu guidance
Keys, display, and menu guidance

The following sections provide an overview of the keys and sockets 
available on your phone and their usage.

Key designations and sockets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Display symbols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Operating your phone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Accessory support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Using labels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
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Key designations and sockets

The following figure shows the keys on the phone.

Mitel 6863 SIP
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Mitel 6865 SIP

The following table describes the keys on the phone with regard to the fig-
ure:
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No
.

Key Description

1 Handset

2 Labels Labels for configurable keys.

3 Message LED color and status signal a specific event.

4 P1-P3 function keys 
(Mitel 6863 SIP)

Freely configurable keys. Preconfigured as:

• System menu.

• Redial list.

• Call transfer.

Function keys P1 to P8 
with LED 
(Mitel 6865 SIP)

8 freely configurable keys (some preconfigured). 
An LED is located next to each function key sig-
naling the functional state. The keys have a dual 
assignment. 

5 Display Monochrome screen.

6 Navigation key with 
selection key

• Navigating through the menu

• Switching line

• Confirming menu selection

7 Deflect key
(Mitel 6865 SIP only)

Transferring a call.

8 Conference key
(Mitel 6865 SIP only)

Setting up conference calls.

9 Call lists key
(Mitel 6865 SIP only)

Calling up the call list menu:

• unanswered

• answered

• Redial list

10 Redial key 
(Mitel 6865 SIP only)

Using the phone number last dialed.

11 Line keys L1 to L2 with 
LED

Mitel 6863 SIP: 2 line keys.
Mitel 6865 SIP: 2 line keys. A total of 9 lines are 
available.

• Seizing a line.

• Answering a call.

• Brokering with simultaneous configuration of 
multiple line keys.

12 Loudspeaker key with 
LED (Mitel 6863 SIP)

• Activating/deactivating open listening.

• Activating/deactivating handset microphone.
Mitel 6863 SIP / Mitel 6865 SIP 13
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Loudspeaker/headset 
key with LED 
(Mitel 6865 SIP)

• Activating/deactivating open listening.

• Activating/deactivating handset microphone.

• Activating/deactivating headset microphone.

13 Hash key Entering # or special characters.

14 Digit keys 1-9 Entering characters and digits.

15 Asterisk key Entering * or space.

16 Microphone key with 
LED

• Activating/deactivating hands-free mode.

• Activating/deactivating handset microphone.

• Activating/deactivating headset microphone 
(Mitel 6865 SIP only).

17 Volume keys Adjusting volume.

18 Settings key Calling up a local settings menu (options list).

19 Hold key • Holding an active call.

• Taking back a call from hold.

20 End key • Ending a call.

• Back to display in idle state.

• Exiting editor without changes.

21 Speaker

22 Rear (Mitel 6863 SIP):

• 100BaseT dual connection for PC and LAN.

• Connection for power supply.

• Connection for headset.

• Connection for Power over Ethernet (PoE).

• Connection for wall mounting.

Rear (Mitel 6865 SIP):

• Connection for expansion key module.

• Connection for power supply.

• Combined four-pin module connection with DHSG headset connection1).

• GigE dual connection for PC and LAN.

• Connection for headset.

• Connection for Power over Ethernet (PoE), class 2.

• Connection for wall mounting.

No
.

Key Description
14 Mitel 6863 SIP / Mitel 6865 SIP
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Display symbols

1) Use the headset connection for headsets only. Connecting another device may cause dam-
age to your phone and void your warranty.

Call connection states, info

• Context-dependent softkey

• Scrolling back through the menu

• Navigate cursor

• Switching line

• Context-dependent softkey

• Goes forward one step in the menu

• Navigate cursor

• Confirming menu selection

• Switching line

• Context-dependent softkey

• Navigating through the menu

• Navigating to display in idle state

• Context-dependent softkey

• Navigating through the menu

• Confirming menu selection

• Navigating to display in idle state

Incoming call

Connected

New voice message

F: Forwarded voice message

G: Voice message to another voice mailbox

Activated setting

Mitel Hi-Q™ audio technology

Data/voice encryption
Mitel 6863 SIP / Mitel 6865 SIP 15
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Operating your phone

Most keys and functions are described in the key legend. Other over-
views and operating aids can also be found here.

Overview system menu
The system menu is accessed using the softkey Menu. This contains the 
following menu entries. Refer to the relevant chapters of this user’s guide 
for further information on these menu entries.

Using a softkey/navigation key
Softkeys are the keys that are automatically configured with context-
dependent functions by the MiVoice Office 400 communications system. 
The functions are displayed on screen and operated with the navigation 
key.

A menu can have several sub-menus. Press the Run softkey (navigation 
key down or right) to access the sub-menu or the selection of available 
editing options or to carry out the action.

Free configurable keys
Mitel 6863 SIP: Your Mitel 6863 SIP has three freely configurable keys 
that are set to the following default functions by your system administrator:

• System menu

MiVoice Office 400 System menu

1. Call lists

2. Directory Lookup

3. Voice Mail

4. Call forwarding

5. Presence

6. Personal call routing

7. Lock / Unlock phone

8. Alarm melodies

9. Software Version
16 Mitel 6863 SIP / Mitel 6865 SIP
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• Redial list

• Call transfer. 

You can configure these programmable keys with another function or call 
number.

Mitel 6865 SIP: Your Mitel 6865 SIP has freely configurable keys. Popular 
functions are set for a specific configurable key by default by your system 
administrator (see "Function key configuration (default key setting) - Over-
view", page 17). The remaining configurable keys can be configured with a 
specific action type: Call number, function, busy lamp field.

The key configuration is not made directly on the phone. Available settings 
for the key configuration:

• MiVoice Office 400 communication system: The configuration is 
made by your system administrator in the communication system.

• Self Service Portal: You can use the Self Service Portal (see chapter 
"MiVoice Office 400 Self Service Portal", page 9) where you can config-
ure, change, or delete the keys.

For information about freely configurable keys, see the chapter "Configur-
ing keys", page 87.

Note: A key that you have configured locally on your phone can not be displayed 
or overwritten in the Self Service Portal. Therefore, always configure your 
keys using the Self Service Portal of the MiVoice Office 400 communica-
tion server. 

Function key configuration (default key setting) - 
Overview
Mitel 6863 SIP/Mitel 6865 SIP phones on the MiVoice Office 400 commu-
nication system are delivered with the following function key configuration. 
Please note that your system administrator may change this and your 
phone may therefore differ from this default configuration.

Function key Mitel 6863 SIP Mitel 6863 SIP if defined as a free seat-
ing phone

Key P1 System menu System menu

Key P2 Call list: Redial list Call list: Redial list

Key P3 Call transfer Call transfer
Mitel 6863 SIP / Mitel 6865 SIP 17
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Overview alphanumeric keyboard
The alphanumeric keyboard has a dialpad with digits from 0 through 9, a * 
key, and a # key. Of these, keys 2 through 9 contain letters of the alphabet. 
These dialpad keys can be used for entering digits, password, text, and 
special characters, and also for quickdial. You can use the alphanumeric 
keyboard to dial a phone number to make a call and to press keys as 
required by an Interactive Voice Response (IVR) system. Press the rele-
vant key repeatedly until the character you want is displayed.1)

The alphanumeric keypad is set to the characters listed in the following 
table.2)

Function key Mitel 6865 SIP Mitel 6865 SIP if defined as free seating 
phone

Key P1 System menu System menu

Key P2 Voice mail menu Free seating: Log in/out

Key P3 Request a callback Request a callback

Key P4 Empty1) Empty1)

Key P5 Empty1) Empty1)

Key P6 Empty1) Empty1)

Key P7 Empty1) Empty1)

Key P8 Empty1) Empty1)

1) The key is set to an empty function, meaning the key will not be overwritten by a subsequent 
key configuration.

1) Please note that actual key configuration depends on which keypad is used.

2) Please note that the actual character selection is dependent on the language 
selected.

Upper case Lower case

0 0

1 . : ; = _ , - ’ & ( ) [ ] $ ! 1 . : ; = _ , - ’ & ( ) [ ] $ !

A B C 2 Ä Á À Â Ã Æ Å Ç А Б В Г a b c 2 ä á à â ã æ å ç a б в г

D E F 3 É Ê Д Е Ё Ж Э d e f 3 é è ê Д e ë ж з
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Entering text
Entering numbers and letters: In text mode, press the key repeatedly 
until the required character appears in the display.

Correcting entries: Use the left navigation key to correct any incorrect 
characters.

Confirming entries: An entry or selection can be confirmed using the Run 
softkey.

Closing editor without saving: With the Cancel softkey or the done key, 
you can cancel the entry without saving or go back to the idle state in the 
menu.

LED overview
The message LED and LED in the function / line key signal different events 
and operating states with different colors and light statuses.

G H I 4 Í Ï Î И Й К Л g h i 4 ì í ï î и й к л

J K L 5 М Н О П j k l 5 м н о п

M N O 6 Ñ Ö Ó Ò Ô Õ Ø Р С Т У m n o 6 ñ ö ó ò ô õ ø р с т у

P Q R S 7 ß Ф Х Ц Ч p q r s 7 ß ф х Ч ч

T U V 8 Ü Ú Ù Û Ш Щ Ъ Ы t u v 8 ü ú ù û ш щ ъ ы

W X Y Z 9 Ь З Ю Я w x y z 9 ь з ю я

* <Space> * <Space>

# / \ @ # / \ @

Upper case Lower case
Mitel 6863 SIP / Mitel 6865 SIP 19
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Message LED:

State Description

Flashes fast • Incoming call

• Appointment call

Flashes slowly • New voice message

• Callback requested / Notification

Lit Phone locked

LED in line key:

State Description

Does not light up Line free (line key )

Flashes fast • Incoming call

• Appointment call

Flashes slowly Call party on hold. Call can be answered on any phone.

Lit Connected

LED function key or busy lamp field key (Mitel 6865 SIP only):

State Description

Does not light up • Function is deactivated

• User free (busy lamp field )

Flashes fast User is being called (busy lamp field )

Lit • Function is activated

• User busy (busy lamp field )
20 Mitel 6863 SIP / Mitel 6865 SIP
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Accessory support

Connecting expansion key modules to your phone (Mitel 6865 SIP 
only) gives you additional, freely configurable keys.

Expansion key module Mitel M680
You can connect up to three Mitel M680 expansion key modules next to 
each other on the right of the phone. The Mitel M680 expansion key mod-
ules has the following properties:

• 16 configurable keys. Three expansion key modules would then give 
you an additional 48 configurable keys.

• Each key has a LED for visual signaling.

• The keys on the expansion key module support all key types that are 
supported by your phone's keys, except room keys, operator keys, and 
operator queue overview key. 

• The configurable keys of the expansion key module are operated the 
same way as the configurable keys of your phone.

• The keys must have been configured either by your system administra-
tor or by yourself in the Self Service Portal (see the chapter "MiVoice 
Office 400 Self Service Portal", page 9). 

• Labels for key identification (see chapter "Using labels", page 24).
Mitel 6863 SIP / Mitel 6865 SIP 21
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Expansion key module Mitel M685
You can connect up to three Mitel M685 expansion key modules next to 
each other on the right of the phone. The Mitel M685 expansion key mod-
ules has the following properties:

• Three display levels with 28 configurable keys each (84 configurable 
keys in total). Three Mitel M685 would therefore give you an additional 
252 configurable keys.

• Each key has a LED for visual signaling.

• The keys on the expansion key module support all key types that are 
supported by your phone's keys, except operator keys, and operator 
queue overview key.

• The configurable keys of the expansion key module are operated the 
same way as the configurable keys of your phone.

• The image icons for the busy lamp field keys do not appear on the 
expansion key module. The expansion key module shows only icons 
with the initial letters.

• The keys must have been configured either by your system administra-
tor or by yourself in the Self Service Portal (see chapter "MiVoice 
Office 400 Self Service Portal", page 9).

• If you remove an expansion key module or if you modify the order of the 
connected expansion key modules, the key configuration changes.

• The display contrast setting and the display backlight is taken from your 
phone.
22 Mitel 6863 SIP / Mitel 6865 SIP
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No
.

Key Description

1 A1-A84 function keys
(3 key levels, 28 keys 
each)

Freely configurable keys. An LED is located next 
to each function key signaling the functional state.

2 Function key for level 1, 
2, 3

Call up the desired level.

2

1
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Using labels

Printing and attaching the labels
Labels can be created and printed using the Self Service Portal (see chap-
ter "MiVoice Office 400 Self Service Portal", page 9).

Mitel 6863 SIP / Mitel 6865 SIP:

1. Create and print the label using Self Service Portal (Important printer 
settings: "Page scaling for printing: none").

2. Cut out the labels according to the crop marks.
3. Remove the cover and insert the label into the recess.
4. Re-insert the cover into the recesses on the keypad.

Mitel M680 (Mitel 6865 SIP only):

1. Create and print the label using Self Service Portal (Important printer 
settings: "Page scaling for printing: none").

2. Cut out the labels according to the crop marks.
3. Remove the cover and insert the label into the recess.
4. Re-insert the cover into the recesses on the keypad.
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Phoning

The following sections explain the features provided by your phone 
for more efficient use.

Making calls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Initiating calls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

Using functions before/while in a call . . . . . . . . . . . . . . . . . . . . . . . . . .  35

Using further functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

Overview of available functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

Organizing absences from the desk . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

Operating call lists and voice messages. . . . . . . . . . . . . . . . . . . . . . . .  65

Organization within the team (busy lamp field, Mitel 6865 SIP only)  . .  68

Line keys on the key telephone (Mitel 6865 SIP only)  . . . . . . . . . . . . .  69

Using functions with Mitel OpenCount  . . . . . . . . . . . . . . . . . . . . . . . . .  71

Setting functions by remote control. . . . . . . . . . . . . . . . . . . . . . . . . . . .  72
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Making calls

This section explains how to set your calls.

Answering, ending or rejecting a call
Answering a call: The phone rings and the message LED and line key 
LED flash. If the caller's phone number or name is received, it is shown on 
the display. If the phone number is stored in the private phone book or in 
the MiVoice Office 400 communication system, the display also shows the 
corresponding name.

Open listening: With the open listening mode function, the loudspeaker is 
activated in addition to the handset so that other people in the room can 
listen to the call.

Rejecting a call: As long as you have not answered a call, you can reject 
it during the ringing phase.

Answering a call with the handset:
Pick up the handset.

Answer a call with the line key
Press the line key and pick up the handset.

Open listening during a call:
Activate: Press the loudspeaker or loudspeaker/headset key.
Deactivate: Press the loudspeaker or loudspeaker/headset key again.

Ending a call in open listening mode:
Press the loudspeaker or loudspeaker/headset key and put down the handset.

Note: If you merely replace the handset, the phone switches to the hands-free mode.

Ending a call:
Put the handset on-hook or press the End key.

Rejecting a call:
Press the End key during the ringing phase.
➔The connection is rejected and, depending on the system configuration, the 

caller either hears the busy tone or is forwarded to a preconfigured destina-
tion.
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Using your phone in hands-free mode
You want other people to join the conversation or to have your hands free 
while making the call.

The hands-free mode function activates the loudspeaker and the micro-
phone. Make sure the hands-free microphone is not obstructed. The 
sound quality is improved if you set the volume of your phone to a low set-
ting.

Automatic hands-free mode1): The function Automatic hands-free allows 
you to answer a call without picking up the handset or pressing a key. The 
following settings are available. This function Automatic hands-free can 
only be activated/deactivated by your system administrator in the MiVoice 
Office 400 communication system.

1) from MiVoice Office 400 communication server software version R4.0 SP1 
onwards

Menu Description

Off Automatic hands-free is always deactivated.

Announcement only Automatic hands-free is only activated when you are 
receiving an announcement.

On Automatic hands-free is always activated. Your phone 
signals an incoming call with two short signal tones and 
then switches to hands-free mode automatically.

Answering/ending a call in hands-free mode:
Answer: Press the loudspeaker or loudspeaker/headset key or line key.
End: Press the End key.

Hands-free during a call:

1. Press the loudspeaker or loudspeaker/headset key.

➔Open listening is activated.

2. Put the handset on-hook.

➔Hands-free is activated.

To continue the call with the handset:
Pick up the handset.
➔The loudspeaker and hands-free microphone are now deactivated.

Ending a call:
Put the handset on-hook.
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Muting the microphone
In the middle of a call you want to talk briefly with other persons in the 
room without your call partner hearing your conversation.

You can switch the microphone on and off during a call, regardless of 
whether you are using the handset, headset or hands-free system.

Using a headset (Mitel 6865 SIP only)
To make a phone call with the headset.

If you answer a call in headset mode using the loudspeaker/headset key, 
the call is provided on the headset. Alternatively you can also answer the 
call by picking up the handset.

All headset mode configuration options can be found in chapter "Setting 
the audio properties", page 76. Further information can be found in the 
user guide for your headset.

Answering/ending a call in Automatic hands-free mode:
Answer: Your phone signals an incoming call with two short signal tones and 
then switches to hands-free mode automatically.
End: Press the End key.

Switching the microphone on and off during a call:
Activate: Press Microphone key.
Deactivate: Press the Microphone key once again.
➔The microphone is activated/deactivated. The LED on the Microphone key 

flashes/does not flash (Mitel 6865 SIP only).

Answering a call with the headset:
Press the key on the headset or the loudspeaker/headset key on the phone.

Ending a call with the headset:
Press the key on the headset or the loudspeaker/headset key on the phone.
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Initiating calls

This section explains some convenient features provided by your 
phone for making a call.

Dialing with the phone number
You want to call someone and key in that person's phone number.

With call preparation you can enter a phone number without it being dialed 
automatically, so you have time to check the number and, if necessary, 
correct it. The number is not dialed until you go off-hook, for example by 
picking up the handset or by pressing the dial softkey.

Dialing from the phone book (directory lookup)
You want to make a call by entering a name.

With directory lookup, you can search for a contact in your private phone 
book, system phone book or a connected external phone book. The 
response time may vary depending on the size and the number of phone 
books connected. The following search options are available:

Dialing with the phone number:
Press the digit keys of the phone number.
➔Use the navigation key to the left to delete any incorrect character.

Pick up the handset or press the Dial softkey.

Menu Description

Quickdial With Quickdial you only need to press the digit keys for 
each letter once, even though each key is assigned sev-
eral letters. An efficient algorithm provides quick search 
results.
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Tips for
search
input:

• Press each of the corresponding digit keys once for the first few letters 
of the name you are looking for. For each letter, the display shows the 
corresponding digit, for example a "6" for the letter "n".

• Ask your system administrator whether you should start with the sur-
name or the first name.

• The search function is not affected by upper/lower case and special 
characters.

• More information on the phone books can be found in chapter "Phone 
book management", page 82.

Dial by name Enter the corresponding letter for dialing by name.
The surname and first name have to be separated by a 
space (*-key).

Advanced search If you select Advanced search, you can search directly in 
the connected external phone books. This function is not 
available if no external phone book is connected.
The surname, first name and town each have to be sep-
arated by a space (* key), for example "no s so" for Noble 
Stephen in Solothurn.

Menu Description

Directory lookup:
Press the function key for Menu.

Scroll to Directory Lookup and press the navigation key to the right.

Scroll to Quickdial, Dial by name or Advanced search and press the navigation 
key to the right.

Directory lookup with quickdial: Enter the first few letters of the name you 
are looking for using the corresponding digits.
Directory lookup with dialing by name: Enter the first few letters of the name 
you want.
Directory lookup with advanced search: Enter the first few letters of the 
name you are looking for and the town (each separated by a space).

Press the Execute softkey.
➔Names list (or List empty, if the phone is unable to find a matching user) is dis-

played.

Scroll through the list and select the user you want.

Pick up the handset.
➔The phone number displayed is dialed.
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Selecting from the call list
You want to call a user from one of the three call lists. You can choose 
from the following call lists:

Your phone automatically stores the person's phone number and name in 
a call list in the MiVoice Office 400 communication system. Within the one 
number user concept (see chapter "One number user concept", page 8) 
you can call back users through one of these call lists. An individual call list 
contains a maximum of 30 entries. More information on call lists can be 
found in chapter "Editing options for the call list", page 65.

The call lists can be operated through the call list key, the redial key, the 
system menu, or a function key (see chapter "Configuring keys", page 87).

Menu Description

Unanswered calls List of callers who tried to reach you when you were 
absent. The number of missed calls are signaled on the 
display.

Answered calls List of calls answered.

Redial list List of calls made.

Call list for unanswered/answered calls:

Mitel 6863 SIP: Press the function key for Menu. Scroll to Call list and press the 
navigation key to the right.
Mitel 6865 SIP: Press the call list key.

Scroll to Unanswered calls, or Answered calls and press the Select key.
➔A list of the most recent unanswered or answered calls (including the pres-

ence status of the contact) is displayed.
You can also press the navigation key to the right to view the most recent unan-
swered/answered calls/conversations.

Use the up and down navigation keys to scroll through the entries and select the 
user you want. 

Press the Detail softkey, or right navigation key, or Select key to view the 
detailed information about the selected user.

Press the Dial softkey, or the Loudspeaker/Headset button, or pick up the hand-
set to dial the selected user’s phone number.

Note: After the call has been successfully connected, the entry is deleted from the 
unanswered call list.
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Dialing with a configurable key/ busy lamp field
You want to call someone whose phone number is stored under a configu-
rable key or a busy lamp field.

To find out how to configure a configurable key, refer to chapter "Configur-
ing keys", page 87.

Dialing with the line key
You can make a call through a line key.

Mitel 6863 SIP: Your phone is equipped with two dedicated line keys with 
LED (L1, L2).

Mitel 6865 SIP: Your phone is equipped with two dedicated line keys with 
LED (L1, L2). Your system administrator can set up to seven additional line 
keys (making a total of nine). The actual number of line keys depends on 

Redial list:
Press the Redial key.
➔A list of the most recent dialed numbers (including the presence status of the 

contact) is displayed.

Use the up and down navigation keys to scroll through the entries and select the 
user you want. 

Press the right navigation key or the Select key to view detailed information 
about the selected user.

Press the Dial softkey, or the Loudspeaker/Headset button, or pick up the hand-
set to dial the selected user’s phone number.
➔The call number of the user is dialed.

Phoning with the handset:

1. Pick up the handset.

2. Press the desired configurable key/busy lamp field.

➔The phone number is dialed.

Using your phone in hands-free mode:
Press the desired configurable key/busy lamp field.
➔The phone number is dialed.
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the system configuration. Press a fix line key directly or select a line by 
pressing the horizontal navigation key to the right or left. The display will 
show the dialed line number (L1, L2 etc.).

You can switch the line by pressing the key. The active call is automatically 
put on hold locally.

Line keys are stored on configurable keys by your system administrator 
(see chapter "Line keys on the key telephone (Mitel 6865 SIP only)", 
page 69).

Activating another Mitel phone for making calls
You want to make a call on another Mitel phone using your personal set-
tings, for example on a colleague’s phone or in a meeting room.

You can activate another Mitel phone to make an internal or external call 
using your personal settings, even if the phone is locked for external calls. 
You can activate the phone for a business or private call. Once you have 
activated the phone using a function code and your PIN, dialing by your 
private phone book is available. The called party's display shows your per-
sonal phone number and not the number of the phone from which you are 
making your call. Any call charges incurred will be charged to you. The call 
number dialed is not stored in the last-number redial list.

Dialing with the line key:
Enter the phone number.

Press a free line key.
➔The phone number is dialed. The LED on the line key lights up.

Holding the call and switching lines:
Press a second, free line key or select a new line key with the horizontal navi-
gation key.

Enter the phone number.
➔The call is held on line key 1 and the call on line key 2 is active.

Note: Press line key 1 to return to your conversation partner on line 1 (see also chap-
ter "Brokering between an enquiry call party and your call partner", page 40).
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Automatic call waiting in case of internal user
You would like to talk to an internal user whose line is currently busy.

By using the function Automatic call waiting1), this user in informed that 
you would like to talk to him. When you use the call waiting function, the 
user receives a call waiting tone (duration and frequency of the tone 
depend on system settings) and your phone number or name appear on 
their display. The user may accept or refuse your call.

Requirements:

• Your system administrator must authorise you to use the function call 
waiting in the MiVoice Office 400 communication system.

• The internal user must not have blocked the function call waiting on 
their phone (see chapter "Activating protection against call types", 
page 82 for configuration).

Business calls:

1. Enter function code #36 for a business call.

2. Enter your internal phone number.

3. Enter your PIN.

4. Enter the internal or external phone number with the exchange access digit.

Pick up the handset.
➔The phone number displayed is dialed.

Note: When you hang up, dialing by name and your private phone book remain avail-
able for a whole minute so you can make another call.

Private calls:

1. Enter function code #46 for a private call.

2. Enter your internal phone number.

3. Enter your PIN.

4. Enter the external call number directly, without the exchange access digit.

5. Pick up the handset.

➔The phone is now enabled; the external user is called.

Note: The default PIN setting ‘0000’ is not accepted (for more information on the PIN, 
see chapter "Changing the PIN", page 80).

1) from MiVoice Office 400 communication server software version R4.0 SP1 
onwards
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Note: If the user is making an enquiry call or is in a conference, the function 
Automatic call waiting cannot be used.

Replying to call waiting

Using functions before/while in a call

This section explains the special features provided by your phone 
before you make a (second) call or while you are in a call.

Request a callback
You want to talk to a certain person. The person is busy or does not 
answer. You can make callback requests to both internal and external 
users. Not all providers support this function.

Call waiting:
The person you want to talk to is busy. The phone automatically executes the 
function call waiting.

Note: If the user declines the call request or if the function call waiting cannot be exe-
cuted, the connection is terminated (busy tone) or the call is redirected to a pre-
defined phone, depending on the system configuration.

Answering the call:
Press the Answer softkey or the line key.
➔The first conversation partner is put on hold. Connected to the party using the 

call waiting function.

Note: Please see chapter "Enquiry call during a call", page 38, "Brokering between an 
enquiry call party and your call partner", page 40 or chapter "Making a confer-
ence call", page 41 for further information.

Rejecting a call:
Press the Ignore or the End softkey.
➔You will still be connected to the original partner. Depending on the system 

configuration, the caller either hears the busy tone or is forwarded to a pre-
configured destination.
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If the called party is busy, you can activate an automatic callback. In this 
case, your phone will start ringing as soon as the party you are trying to 
reach goes on-hook. When you pick up the handset, the person you want 
to call is dialed directly. If the called party does not answer, you can also 
request a callback. The user then obtains a message indicating your call-
back request on his display.

You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Notes: • You can activate only one callback at a time.

• An unanswered callback will be automatically cancelled by the system 
after about 30 minutes.

To answer the callback request
Someone has asked you to call back. The display shows Callback 
requested from number (for example: Callback 56022).

You cannot automatically answer a callback request on your phone. You 
can either enter the call number manually or use a CTI client, for example 
the Mitel OfficeSuite.

Activating callback:
You called someone and hear the busy tone or the ring-back tone. Press the 
function key for Callback.
➔Depending on the communication system, you hear the acknowledgement 

tone.

Put the handset on-hook.
➔The display shows Call expected. The LED of the function key is lit 

(Mitel 6865 SIP only).

Clear callback:
Press the function key for Callback. 
➔Callback request is deleted.

Answering the callback request:
Enter a phone number in call preparation.
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Hide number
You do not want your call number to appear on the terminal display of a 
called party in the public network. The following options are available here:

You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Notes: • Your call number can only be hidden if you select an external call num-
ber.

• This feature depends on the range of services offered by your provider.

Putting a call partner on hold
You want to briefly interrupt the active call.

You can put the call party on hold and then take them back again on the 
same phone.

Pick up the handset or press the Dial softkey.

Note: You cannot delete a callback request.

Menu Description

Permanent The call number is never displayed.

Per call Call number should only be restricted for certain calls. 
This function must be activated before dialing the call 
number.

Activating/deactivating calling line identification restriction permanently:
Press the function key for Hide number.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only). You phone number is hidden in all out-
going calls.

Activating CLIR per call:

1. Press the function key for Hide number.

2. Enter the call number and press the Enter softkey.

➔Call number is dialed and your number is not displayed to the called party.
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Parking conversation partner
You would like to keep the person you are talking to on hold without block-
ing a phone line.

You may park1) the person you are talking to and then pick up the call 
again on the same phone on which you parked the person.

You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Enquiry call during a call
You want to call someone else briefly without losing your current call part-
ner. Then you want to resume your conversation with your original call 
partner.

Putting the active call party on hold:
Press the Hold key.
➔The call party is put on hold. The LED on the line key flashes.

Take back the call party on hold:
Press the Hold key or the flashing line key.
➔The call is active again.

1) from MiVoice Office 400 communication server software version R4.0 SP1 
onwards

Parking the active call party:
Press the function key for Park and put down the handset.
➔The call party is parked. The LED of the function key is red (Mitel 6865 SIP 

only).

Notes: The display returns to idle. The person you talked to will remain parked until they 
put down the handset.

Recommence conversation with the parked call party:

1. Press the function key for Park.

➔Hand-free mode is activated.

2. Pick up the handset.

➔You are connected via the handset.
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With the Enquiry function you can call someone else in the middle of a call 
and put your original call partner on hold. You can make enquiry calls to 
both internal and external users.

Setting up an enquiry call (you are in a call):
Press a free line key (select using the horizontal navigation key, if necessary).

Enter the call number of the enquiry partner and press the Dial softkey.
➔Enquiry call party is called; first call partner is put on hold.

Notes: • You can also set up an enquiry call by pressing the busy lamp field key to 
which you have saved the enquiry call party.

• If the other user does not answer, you can cancel the enquiry call with the end 
key and take back the first call with the flashing line key.

Ending the enquiry call:
Press the End key.

Recommence conversation with the first call party:
Press the flashing line key.
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Brokering between an enquiry call party and 
your call partner
You are talking with an enquiry call party and have your first call partner on 
hold. You want to be able to switch back and forth between the two.

In an enquiry call you can use the brokering function to switch back and 
forth between an enquiry call party and the party on hold. Brokering is pos-
sible with both internal and external users. You can also broker between 
conference parties as a group and an enquiry call party.

Note: See chapter "Enquiry call during a call", page 38 for enquiry calls.

Brokering (to switch back and forth between the callers):
You are in an active call and have set up a connect to another call party with the 
Enquiry function.
Press the flashing line key.
➔Your call partner changes. The other call party is put on hold.

Note: You can also switch between call parties by pressing the corresponding busy 
lamp field key to which you have saved the call party.

Terminating a call:
Press the End key.

Recommence conversation with the first call party:
Press the flashing line key.
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Making a conference call
You want to make a conference call.

A conference call allows you to connect three call parties. From a confer-
ence call, you can initiate an enquiry call to someone else. You can broker 
between the conference participants and the enquiry call party. Depending 
on the system configuration, a conference call can consist of up to six con-
ference participants. You can hold a conference call with internal and 
external users.

Mitel 6863 SIP: You must save this function to a configurable key using 
Self Service Portal (see chapter "Configuring or deleting a key assign-
ment", page 88).

Note: If you have a user account for the Self Service Portal, you can create con-
ference rooms there (see chapter "MiVoice Office 400 Self Service Portal", 
page 9).

Setting up a conference (you are connected):

Press the function key for Conference.
Press the Conference key. (Mitel 6865 SIP only)

Enter the phone number of the second conference call party.

Press the Dial softkey.
➔The conference party answers the call.

Press the function key for Conference.
Press the Conference key. (Mitel 6865 SIP only)

Notes: • You can also set up a conference by pressing the busy lamp field keys to 
which you have saved the call party.

• You can change the procedure by first starting an enquiry call before you set 
up a conference.

Leaving a conference call:
Put the handset on-hook or press the End key.
➔The other conference parties remain in the call.
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Transferring a call
You want to put your call partner through to someone else.

With the call transfer function you can connect your call partner with some-
one else. You can connect internal and external users with one another. 
You can transfer the call with or without prior notice.

Mitel 6863 SIP: You must save this function to a configurable key using 
Self Service Portal (see chapter "Configuring or deleting a key assign-
ment", page 88).

Menu Description

Call transfer with prior 
notice

You only transfer the call after you have first talked to the 
second call party yourself.

Call transfer without 
prior notice

Without talking to the second call party, you transfer the 
call to them by hanging up the handset immediately after 
dialing the call number.

Call transfer with prior notice (you are in a call):

Press the function key for Call transfer.
Press the forward key. (Mitel 6865 SIP only)

Enter the call number of the second call party and press the Dial softkey (or 
press the corresponding busy lamp field).
➔The second call party is called; first call party is put on hold.

Wait until the person has answered the call.
➔If the second user does not answer, you can cancel the second call using the 

softkey Cancel and recommence the first call by pressing Pick up.

Announce the call party.

Put the handset on-hook.
➔Your first call partner and the other person are now connected with each 

other.

Call transfer without prior notice (you are in a call):

Press the function key for Call transfer.
Press the forward key.
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Take (pick up own call)
You want to transfer a call from one phone to another without interrupting 
the connection (for example, from a desk phone to a cordless phone).

The take function can be used to transfer calls between your phones. 
Requirements: You are using the one number user concept (see chapter 
"One number user concept", page 8).

You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Starting announcement
You want to speak directly to an internal user or an announcement group 
via the loudspeaker - where available - without expecting an answer (simi-
lar to an intercom). The recipient is alerted to the announcement by two 
short signal tones. You are immediately unilaterally connected via the 
loudspeaker.

If the internal user has secured their phone against announcements (con-
figuration see chapter "Activating protection against call types", page 82), 
you cannot contact them using an announcement. You will get the 
engaged tone.

Enter the call number of the second call party and press the Dial softkey (or 
press the corresponding busy lamp field).
➔The second call party is called; first call party is put on hold.

Wait for the first ring tone.

Put the handset on-hook.
➔The other party is then called directly by your first call partner.
➔Recall: If the other party does not answer, the call comes back to your phone.

Note: You can change the procedure by first starting an enquiry call before call trans-
fer.

Call transfer with prior notice (you are in a call):

Picking up your own call (you are in an active call):
Press the function key for Take.
➔After a brief moment, you are connected with the caller on another phone.
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The announcement function must be saved to a configurable function key 
with Self Service Portal (see "Configuring or deleting a key assignment", 
page 88). You can either configure the function key directly with a desig-
nated user or input the call number manually each time.

Starting the emergency announcement:

In addition to normal announcements, the MiVoice Office 400 communica-
tion system also allows for emergency announcements. It differs from a 
normal announcement in the following aspects:

• You cannot reply to or stop an emergency announcement.

• You cannot block an emergency announcement.

• An emergency announcement may only be executed using function 
codes. You will find a list of all function codes in the user's guide “Fea-
tures Overview Mitel 415/430/470” on the Mitel DocFinder.

Announcement to a group:

• The announcement will only be received by phones which both have 
authorisation to receive announcements and are not in use.

• If receipt of announcements is not authorised on any of the phones in 
the announcement group or all the phones are in use, you will hear the 
busy tone.

• Group announcements are always conducted with a one-sided connec-
tion.

• The group number must be entered as two digits.

Start announcement to a user:

1. Press the function key for <Announcement to a user>.

2. Depending on settings, enter the number and press the Select softkey.

➔The user is alerted to the announcement by two short tones on the loud-
speaker. The one-sided connection is made, you can talk.

Start announcement to a group:

1. Press the function key for <Announcement to a group>.

2. Depending on the settings, enter the two digit group number.

➔The user group is alerted to the announcement by two short tones on the 
loudspeaker. The one-sided connection is made, you can talk.
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Receiving an announcement
You will be alerted to the announcement with two short signal tones and 
spoken to directly via the loudspeaker over a one-way connection. The 
display shows Announcement from.

In order to be able to receive an announcement, your phone must be nei-
ther in use nor block announcements (configuration see chapter "Activat-
ing protection against call types", page 82).

Receiving the emergency announcement:

In addition to normal announcements, the MiVoice Office 400 communica-
tion system also allows for emergency announcements. It differs from a 
normal announcement in the following aspects:

• You cannot reply to or stop an emergency announcement, but listen to it 
with the handset.

• You cannot block an emergency announcement.

Announcement to a group:

• The announcement will only be received by phones which both have 
authorisation to receive announcements and are not in use.

• If receipt of announcements is not authorised on any of the phones in 
the announcement group or all the phones are in use, you will hear the 
busy tone.

• Group announcements are always conducted with a one-sided connec-
tion.

Recording a call
You want to record an active call with your call partner.

You may record an active call as soon as your system administrator has 
configured at least one of your e-mail addresses in the MiVoice Office 400 
communication system. Your call party can be an internal or an external 

You will be alerted to the announcement with two short signal tones and 
spoken to directly via the loudspeaker.

Stop announcement:
Press the End key.
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user. The recordings are made and backed up only as wave files in your 
individual e-mail boxes. You can find a call recording overview in your e-
mail box. Contact your system administrator for more information.

You can start recording calls in the following situations:

• during an active call;

• During a conference call (with maximum two participants)

• During an incoming/outgoing call

• in call preparation;

• During dialing with a busy line.

Call recording only starts when the connection is set up. Therefore, no 
ring-back tones or wait tones are recorded.

Call recording is temporarily interrupted during an enquiry and an e-mail is 
sent with the recording made up till then. Recording restarts automatically 
once the call connection with the enquiry call party is set up and/or once 
the call connection with the first correspondent is restored.

The maximum recording time for each .wave file depends on the system 
configuration. When the predefined or maximum recording time is 
reached, the recording stops automatically, the file is sent to your e-mail 
address and a new recording starts at the same time. Contact your system 
administrator for more information.

You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Notes: • Recording calls may infringe on your national data protection provisions 
or be permitted only under certain circumstances. If you intend to use 
this function notify your call party in advance.

• You cannot record a conversation involving more than two call parties 
(enquiry call, conference). The recording is automatically stopped if you 
park your call party or put him on hold.

Recording a call:
Press the function key for Call recording: start/stop as soon as you have an 
incoming/outgoing call or an active call.
➔The call is recorded. The LED on the function key is switched on 

(Mitel 6865 SIP only).
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Activating discreet ring
You do not want to be disturbed by the ring of the phone. You do not, how-
ever, want to switch off the phone.

As an alternative to the usual ring, your phone has a discreet ring option. If 
you have activated discreet ring, the phone only rings once.

This function must be saved to a function key over the Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Activating do not disturb
You do not want to receive any calls for the time being.

With the do not disturb function, you can stop calls being made to you if 
you are busy or are not otherwise able to take any calls. Your phone does 
not ring and is set to busy for incoming calls. Your incoming calls are auto-
matically forwarded to a call forwarding destination that has been config-
ured by your system administrator.

Your system administrator must enable this function in the MiVoice 
Office 400 communication system.

This function must be saved to a function key over the Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Stopping the call:
End the recording by pressing the function key Call recording: start/stop again.
➔The recording is sent to your e-mail address.

Note: The LED on the function key remains lit while the recording is in progress. The 
LED starts to flash before the recording reaches its maximum preset duration. 
Once the maximum duration is reached (or the memory is full), the recording is 
stopped and the LED goes off (Mitel 6865 SIP only).

Activating/deactivating discreet ring:
Press the function key for Discreet ring on/off.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).
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Activate/reply to intrusion
You want to implement intrusion in a current call.

Intrusion allows you to access a current call between two call parties and 
listen to their conversation. The call party to which you have initiated intru-
sion is notified (display and sound signals). Your call party can then 
respond to intrusion or reject it.

You can block intrusion; see chapter "Protecting yourself against calls", 
page 81.

You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Notes: • Your system administrator must grant you intrusion rights.

• Intrusion may infringe on your national data protection provisions or be 
permitted only under certain circumstances. If you intend to use this 
function, you should therefore notify your call party in advance.

Menu Description

Do not disturb (busy) 
on/off

Your phone does not ring and is set to busy for incoming 
calls.

Do not disturb (for-
warding) on/off

Your phone does not ring and is set to busy for incoming 
calls. Incoming calls are automatically forwarded to a 
destination that has been configured by your system 
administrator.

Activating/deactivating do not disturb:
Press the function key for Do not disturb (busy) on/off or Do not disturb (forward-
ing) on/off.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only). Your callers hear the busy tone.

Activating intrusion (the users are talking):

1. Press the function key for Intrusion.

2. Enter the call number of the user you want as per the key configuration.

➔The intrusion tone indicates that the function has been activated.
➔If the user has blocked intrusion, connection set up will be cancelled.
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Activating/answering silent intrusion
Silent intrusion (intrusion without prior notice) is a variation of the intrusion 
function and is primarily used in call centres.

Another user can connect to your active call and listen to the conversation 
without you or your call party noticing. Unlike with intrusion, there is neither 
a display nor a sound signal to indicate use of the function.

You cannot reject silent intrusion (but you can block it; see chapter "Pro-
tecting yourself against calls", page 81). The microphone of the third user 
remains off. The third user can, however, enter the conversation at any 
point by enabling his or her microphone or pressing the intrusion function 
key.

You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Notes: • Silent intrusion must be enabled in the communication system.

• Your system administrator must grant you silent intrusion rights.

• Silent intrusion may infringe on your national data protection provisions 
or be permitted only under certain circumstances. If you intend to use 
this function, you should therefore notify your call party in advance.

Answering intrusion:
Press the Answer softkey.
➔You will be connected with the user who has activated intrusion; the first call 

party is put on hold.

Rejecting intrusion:
Press the End softkey.
➔Intrusion will be rejected; you remain connected to your first call party.

Activating silent intrusion (the users are talking):

1. Press the function key for Silent intrusion.

2. Enter the call number of the user you want as per the key configuration.

➔The function is activated.
➔If the user has blocked intrusion, connection set up will be cancelled.

Answering silent intrusion:
There are neither display nor sound signals on your phone to indicate silent 
intrusion.
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Using further functions

This section explains some more convenient features provided by 
your phone. All functions you can save under a configurable key can 
be found in chapter "Overview of available functions", page 56.

Activating personal call routing
You want to specify which of your phone shall ring when you receive a call.

You can specify the phone on which a call is signaled with personal call 
routing.

Your system administrator set up multiple phones with the same phone 
number in the one number user concept for you (see chapter"One number 
user concept", page 8). The system administrator has also assigned you 
permission to configure routing in the Self Service Portal. This allows you 
to set up 5 routings in the Self Service Portal for a range of situations 
("Office", "Home Office", "On the road").

You can only answer a call on the phone on which the call is signaled. If 
you have not configured a call routing, the default setting (all phones are 
ringing) is used as standard.

The following options are available on your phone for further editing of per-
sonal call routing:

Menu Description

Activate Activating personal call routing.

Modify Renaming personal call routing.

Change settings The personal call routing settings can only be changed 
by your system administrator or yourself in the Self Ser-
vice Portal.

Delete A personal call routing can only be deleted by your sys-
tem administrator or yourself in the Self Service Portal.

Activating/deactivating personal call routing
Press the function key for Menu.
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You can also store your individual call routing profiles over the Self Service 
Portal on a function key and quickly activate or deactivate your desired call 
routing profile by simply pressing that key.

Activating Ring Alone
You want to specify the phone on which an incoming call is signaled 
acoustically.

If your system administrator has set up one phone number for several 
phones (see "One number user concept", page 8),you can use Ring Alone 
to define on which phone a call will be signaled acoustically. As soon as 
you activate Ring Alone on one phone, the ring tone is deactivated for all 
other phones. An incoming call is signaled in the display of all phones. You 
can answer the call on any of the phone; once the call is answered, other 
phones go back to the idle state.

You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Scroll to Personal call routing and press the navigation key to the right or press 
the Select softkey.
➔A list of your routings is displayed.

Select the call routing you want and confirm with the Activate softkey.
➔The selected routing is activated and another is deactivated.

Renaming personal call routing:
Press the function key for Menu.

Scroll to Personal call routing and press the navigation key to the right or press 
the Select softkey.
➔A list of your routings is displayed.

1. Scroll to the call routing you want to rename and press the softkey Modify.

2. Enter the name and confirm with the Select softkey.

Press the function key for the desired call routing profile.
➔Call routing is activated/deactivated. The LED on the function key is switched 

on/off (Mitel 6865 SIP only).
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Note: When you have activated ring alone but deactivated the personal call rout-
ing for a phone in parallel, an incoming call is not acoustically but only 
visually signaled.

Locking/Unlocking your phone
You need to leave your desk and want to ensure that no-one can alter your 
phone's settings, look at your private data, or make calls from your phone.

You can lock your phone with a 2 to 10-digit PIN (for more information on 
the PIN, see chapter "Changing the PIN", page 80).

You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Activating/deactivating ring alone
Press the function key for Ring Alone on/off.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).

Activating the phone lock:
Press the function key for Phone lock on/off.
➔The phone is locked and can only be unlocked using your PIN. Phone is 

locked is displayed.

Deactivate the phone lock:

1. Press the function key for Phone lock on/off.

2. Enter the PIN and confirm with the Enter softkey.

3. Confirm the security prompt with the Yes softkey.

Note: Use the following function codes (see also Features Overview Mitel 
415/430/470 user guide on the Mitel DocFinder), to activate or deactivate the 
phone lock for all phones within the one number user concept (see "One num-
ber user concept", page 8):

• Activating the phone lock: Enter the function code *33* <PIN> #

• Deactivate the phone lock: Enter the function code #33* <PIN> #
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Acknowledging an appointment call
You can set a call to remind you about an appointment, for example. 
Appointment call is displayed as soon as an appointment call is received. 
Without acknowledgement, the appointment call will ring for 1 minute.

The following options are available: You have to enter or change the time 
in the Self Service Portal.

You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

Notes: • If you activated forwarding, the appointment call is not forwarded.

• If you are in call, the appointment call is made as soon as you end the 
call.

Free seating
Free Seating is proposed for workplaces/phones shared by several 
employees. It allows you to log in on each free seating phone and to use it 
with your personal settings as long as you are logged in. Ask your system 
administrator which phones are proposed for free seating.

Logging into a free seating phone:

Menu Description

Single appointment 
call on/off

Activate appointment call on a one-off basis.

Repeat appointment 
call on/off

Activate appointment call permanently

Activates/deactivates appointment call permanently:
Press the function key for Appointment call.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).

Activate single appointment call:
Press the function key for Appointment call.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).

Confirming an appointment call:
Pick up the handset and then hang up immediately.
➔The appointment call is confirmed and ended.
Mitel 6863 SIP / Mitel 6865 SIP 53
eud-1663/2.0 – R6.0 – 06.2018



 Phoning
You log in with your call number and your PIN on a free seating phone. 
Once you are logged in, your personal call lists, phone book and all your 
other personal settings and Hotkeys are available to you immediately. If 
your profile contains expansion key modules, but the phone you have 
logged in to does not, the keys in question will not be available to you. Var-
ious sequences of expansion key modules are correctly recognised.

Notes: • You can only log in to a phone if no other user has yet logged in to that 
phone for free seating purposes.

• You can only log on once to a Free Seating phone. The moment you log 
in to another free seating phone, you are automatically logged off the 
original phone.

Logging off a free seating phone:
To free up a phone, you need to log off again. To ensure a phone is not 
blocked for other users if you forget to log off, your system administrator 
can set up a log off process with an automatic time limit:

• After certain time after log in (e.g. six hours and 30 minutes).

• At a certain time (e.g. 6:30 p.m.)

Notes: • If no user is currently logged in a free seating phone, possibly only 
emergency calls are allowed.

• As long as you do not have your own phone or are not logged on to a 
Free Seating phone, your caller will obtain either the busy signal or be 
forwarded to a preconfigured destination, depending on the system 
configuration.

Log in free seating:
Press the Free Seating:  Log in/out softkey.

Enter phone number and PIN and confirm with the OK softkey.
➔You are now logged in and can use the free seating phone with your personal 

settings. The LED on the function key is switched on (Mitel 6865 SIP only).

Note: The default PIN setting ‘0000’ is not accepted (for more information on the PIN, 
see chapter "Changing the PIN", page 80).
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Hotline
The hotline is typically used for lift phones, emergency phones, or for baby 
alarms or hotline in the hospitality/hotel branch.

A user requires help and picks up the handset or presses the loud-
speaker/headset key. The user is automatically routed to the preconfig-
ured hotline destination number stored in the MiVoice Office 400 commu-
nication system. The person responsible answers the call and is con-
nected with the user seeking help.

Alarm cancellation delay: Your system administrator can set a delay (1-
60 seconds, depending on the Mitel system phone). During this delay the 
user can enter another call number in order not to trigger a call on the 
hotline destination number. If the user does not dial another phone number 
during this predefined time or puts the handset back down again, a con-
nection with the Hotline number is automatically set up. Contact your sys-
tem administrator for more information.

Log out free seating:

1. Press the Free Seating: Log in/out softkey.

➔The display with the call number is displayed.

2. Depending on the system configuration, enter the PIN and confirm with the 
OK softkey.

➔You are now logged off; the free seating phone is now available again to 
other users.

Note: You are automatically logged off if your system administrator has set up an auto-
matic log off process.

Using the hotline:
User needs help. They pick up the handset of their phone or press the loud-
speaker/headset key.
➔A connection with the hotline number is automatically set up after a pre-

defined time without the user having to do anything else.
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Overview of available functions

This section contains a list of all the functions you can store under a con-
figurable key via the Self Service Portal. Please note that the selection of 
functions depends on the selected phone and its authorisation level.

Notes: • More information on how to save functions to a configurable key using 
function commands and a function code can be found in the online help 
for the Self Service Portal (see chapter "MiVoice Office 400 Self Service 
Portal", page 9).

• You will find a list of all function codes in the user's guide “Features 
Overview Mitel 415/430/470” on the Mitel DocFinder. Please note that 
function codes can only be used as prefix dialing on your phone.

Function Description

Agent: Log in/log out Log into/out of the queue as an agent (control of call 
routing in the queue).

Agent: Pause on/off Activate/deactivate agent break.

Agent: Wrap-up time on 
/off

Activate/deactivate agent wrap-up time.

Announcement to group Speak directly to a group of internal users via the 
loudspeaker - where available - without them having 
to first pick up the call. An announcement is a one-
sided connection and is indicated by two short signal 
tones on the recipient phone. Announcement groups 
will be defined by your system administrator. The 
group number must be entered as two digits.

Announcement to user Speak directly to an internal user via the loudspeaker 
- where available - without them having to first pick up 
the call. An announcement is a one-sided connection 
and is indicated by two short signal tones on the 
recipient phone.

Appointment call: Repeat 
on/off

Activates/deactivates an appointment call (see chap-
ter "Acknowledging an appointment call", page 53).

Appointment call: Single 
on/off

Activates/deactivates an appointment call on a one-
off basis (see chapter "Acknowledging an appoint-
ment call", page 53).

Call forw. (CFU) to text 
message on/off

Incoming calls are automatically forwarded to a spe-
cific destination.

Call forw. (CFU) to user 
on/off

Incoming calls are automatically forwarded to a spe-
cific destination.
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Call forw. (CFU) to VM 
on/off

Incoming calls are automatically forwarded to voice 
mail.

Call forw. if busy (CFB) to 
user on/off

If you are busy, incoming calls will be forwarded to 
specific destination (user).

Call forw. if busy (CFB) to 
VM on/off

If you are busy, incoming calls will be forwarded to 
specific destination (voice mail).

Call forw. on no reply 
(CFNR) to user on/off

Incoming calls are forwarded to another destination 
(user).

Call forw. on no reply 
(CFNR) to VM on/off

Incoming calls are forwarded to another destination 
(voice mail).

Call forwarding menu Direct access to the system menu Forwarding (see 
chapter "Call forwarding", page 63).

Call forwarding protection 
on/off

Call forwarding to your phone is not allowed.

Call list: Menu Direct access to the system menu Call list.

Call list: Answered Call list for answered calls.

Call list: Redial Call list for dialed call numbers.

Call list: Unanswered Call list for unanswered calls.

Call recording: Start/stop Record a call. The recordings are stored in your indi-
vidual e-mail inbox only (see chapter "Recording a 
call", page 45). Contact your system administrator to 
configure this function on your phone.

Call transfer Transfer a call to another user with or without prior 
notice.

Control output on/off You can control external electric equipment or instal-
lations using control outputs. For example you can 
use your phone to open and close electric gates or to 
switch the lights on or off throughout a building.

Discreet ring on/off When this function is on, the phone only rings once. 
For further information, please see "Activating dis-
creet ring", page 47.

Do not disturb (busy) 
on/off

Your phone does not ring and is set to busy for 
incoming calls.

Do not disturb (forwarding) 
on/off

Your phone does not ring and is set to busy for 
incoming calls. Incoming calls are automatically for-
warded to a destination that has been configured by 
your system administrator.

Function Description
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Empty The key assignment is configured with an empty 
function. The key serves as a place-holder. If config-
uration on any key is deleted, the configurations on 
the subsequent keys shift their position. This can be 
avoided if instead of deleting the configuration, you 
configure the Empty function on that key.

Free configurable You can use function commands to define a function 
to suit your personal requirements. A function can 
consist of one or more function commands, function 
codes, and the phone number. You can either carry 
out a function directly or store it under a key (see 
chapter "Overview of available functions", page 56).

Free seating: Log in/log 
out

Log into/out of a free seating phone (see chapter 
"Free seating", page 53).

Hide number on/off Permanently prevents your number from being dis-
played to the caller (see chapter "Hide number", 
page 37).

Hide number per call Prevents your number from being displayed to the 
caller once (see chapter "Hide number", page 37).

Home Alone on/off If calls to a user group can only be answered by one 
user, the user in question can activate Home Alone 
on the user group. Then if the user is already in a call, 
all subsequent internal or external calls to the user 
group obtain a busy tone.

Intrusion This function allows you to intrude on a call of a busy 
user with notification (see chapter "Activate/reply to 
intrusion", page 48). 

Meeting centre This function enables access to the MiCollab Audio, 
Web, and Video conferencing from your SIP phones. 
Contact your system administrator to know more 
about the configuration of MiCollab Meeting Centre 
function on your phone.

Message This function triggers a call back or plays a voice 
mail. If the message key is pressed, a call is triggered 
or the guest is connected to the voice mail system 
and can listen to the voice message. The function 
code for the Message function is *#38. 

Park call You would like to keep the person you are talking to 
on hold without blocking a phone line.

Personal call routing menuDirect access to the system menu Call routing (see 
chapter "Activating personal call routing", page 50).

Function Description
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Personal call routing pro-
file on/off

Activate/deactivate call routing profile (under the one 
number user concept).

Phone book:: Local Access to your local phone book. Contacts in the 
local phone book are stored on the phone only (see 
chapter "Phone book management", page 82).

Phone book:: System Direct access to the Directory Lookup system menu. 
Contacts in the system phone book are integrated in 
the MiVoice Office 400 communication system (see 
chapter "Phone book management", page 82).

Phone lock on/off Activate/deactivate phone lock. Outgoing calls are 
not possible, but incoming calls can be answered 
(see chapter "Locking/Unlocking your phone", 
page 52).

Picking up a call from a 
user group

Pick up a call for another user in the user group. Con-
tact your system administrator to configure this func-
tion on your phone.

PIN call Function with OpenCount. Independently from the 
phone you can make external calls for a fee. Credit 
may be limited (see chapter "Activating PIN tele-
phony", page 71).

PIN call rebook Function with OpenCount. You can enter the charges 
and the call information of your outgoing and incom-
ing calls into specific projects (see chapter "Activat-
ing PIN telephony", page 71).

Presence menu Direct access to the system menu Presence (see 
chapter "Controlling the presence status", page 61).

Presence profile on/off Activate/deactivate presence profile. You can select 
a presence profile (profile number 1-4, see chapter 
"Controlling the presence status", page 61).

Redkey:Trigger Actuating a redkey triggers the function configured 
on the connected third party system. Contact your 
system administrator for more information.

Remote maintenance 
on/off

This function lets you set remote maintenance 
access to your communication system permanently. 

Remote maintenance 
onetime on/off

This function lets you set remote maintenance 
access to your communication system on a one-off 
basis.

Request a callback Request a callback if the called party is busy or can-
not be reached (see chapter "Request a callback", 
page 35).

Function Description
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Ring Alone on/off This function lets you specify which of your phones 
signals incoming calls acoustically (as part of the 
one-number user concept, see chapter "Activating 
Ring Alone", page 51).

Run XML function You system administrator creates customer-specific 
XML services (weather report, stock exchange, etc.) 
which you can use on your SIP phone.Redkey:Trig-
ger

Set up conference Set up a conference with two call parties.

Show alarm state Display of the current alarm state. Contact your sys-
tem administrator to configure this function on your 
phone.

Silent intrusion This function intrusion without prior notice allows you 
to intrude on the call of a busy user without notifica-
tion (see chapter "Activating/answering silent intru-
sion", page 49).

Switch group x, position 2
Switch group x, position 3

This function lets you route calls and functions via 
switch groups (with two switch positions).

System menu Access to the MiVoice Office 400 system menu.

Take (pick up own call) Transfer a call from your phone to another phone 
under the one number user concept (see chapter 
"Take (pick up own call)", page 43).

Transparent data This function takes charge of the transparent 
exchange of data between the communication server 
and external applications.

User group all: Log in/log 
out

Log in/out of all user groups. In the user group incom-
ing and internal calls are routed to a group of internal 
destinations according to a preconfigured call distri-
bution.

User group: Log in/log outLog in/out of a user group. In the user group incoming 
and internal calls are routed to a group of internal 
destinations according to a preconfigured call distri-
bution.

Voice mail greeting on/off Activates/deactivates a selected voice mail greeting.

Voice mail greeting: Play Plays back a selected voice mail greeting.

Voice mail greeting: 
Record

Records a selected voice mail greeting.

Function Description
60 Mitel 6863 SIP / Mitel 6865 SIP
eud-1663/2.0 – R6.0 – 06.2018



 Phoning
Organizing absences from the desk

This section explains the different options provided by your phone 
when you want to leave your desk.

The presence function enables you on the one hand to quickly set 
your personal presence state and hence to route the incoming calls 
to the destination you want. It also tells you directly whether the user 
you want is reachable or absent without you having to call him. The 
information details depend on the type of telephone.

Controlling the presence status
You have a choice of five presence profiles for managing your presence 
status:

You can call up the presence of the user you want in the following situa-
tions.

• in Directory Lookup

• in a call list

Notes: • Connected CTI applications can affect your presence status. Contact 
your system administrator for more information.

Voice mail menu Direct access to the Voice mail system menu.

Welcome announcement 
for announcement service 
on/off

Announcement service for incoming internal and 
external calls. If you do not answer an external call 
after a set delay, the user who is calling will obtain an 
announcement. After the announcement the caller 
will then hear the ring-back tone again.

Function Description

Profile number Presence profile

0 Available (default)

1 Absent

2 Meeting

3 Busy

4 Not available
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• All configuration options for a presence profile can be found in chapter 
"Configuring presence profile", page 85.

• Calls you receive while your presence status is busy will be indicated in 
the call list.

The presence status can be managed via the system menu, a function key 
(see chapter "Configuring keys", page 87), or the Self Service Portal (see 
chapter "MiVoice Office 400 Self Service Portal", page 9).

Absence information
You wish to give your caller detailed information about your absence.

If you have configured call forwarding to voice mail in your presence pro-
file, you can choose whether the currently active greeting, the global greet-
ing, one of your personal greetings or an absence information should be 
played back to the caller.

The absence information is available for each presence profile, with the 
exception of Available. Absence information consists of a language-
dependent, predefined audio text. The time and/or date are also given as 
an option. Depending on voice mail configuration, your caller then immedi-
ately has the possibility of leaving a message.

Example: The person you have called is not available until 02:00 p.m. on 
31st January. Please leave a message after the tone.

The absence information is an integral part of a presence profile. All con-
figuration possibilities for this option can be found in chapter "Configuring 
presence profile", page 85.

Note: If your Outlook calendar is not synchronised via Mitel Open Interfaces 
Platform (OIP) with your communication server, you have to manually 
enter and delete the time and date.

Activate/deactivate presence profile:
Press the function key for Menu.

Scroll to Presence and press the navigation key to the right or press the Select 
softkey.

1. Select the presence profile you want and press the Enter softkey.

2. Press the Activate > Enter softkeys.

➔ The presence profile is activated.
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Call forwarding
You want to leave your desk. Calls for you are to be forwarded to a differ-
ent destination (e.g.another user, your voice mail).

With call forwarding, you can forward incoming calls directly to a different 
destination. The following call forwarding options can be selected.

Notes: • One call forwarding applies to all connected phones, in one number 
user concept.

• Only one call forwarding variant at a time is possible.

Set up the absence information:
Press the function key for Menu.

Scroll to Presence and press the navigation key to the right

1. Select the presence profile you want and press the Enter softkey.

2. Scroll to Modify and press the Enter softkey.

1. Scroll to Time or Date and press the Enter softkey.

2. Make the changes and confirm with the Enter softkey.

3. Scroll to Call forwarding and press the Enter softkey.

4. Select Voice Mail and confirm with the Enter softkey.

5. Scroll to VM greeting and press the Enter softkey.

6. Select Absence information and confirm with the Enter softkey.

7. Activate the presence profile.

➔Settings are saved. Your caller hears the selected absence information, fol-
lowed, if applicable, by time and date.

Menu Description

Call forwarding off No CFU is carried out.

Always (CFU) Incoming calls are automatically forwarded to another 
destination (Call Forwarding Unconditional).
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Available call forwarding destinations:

Operation of call forwarding is available via the system menu, a function 
key (see chapter "Configuring keys", page 87), or the Self Service Portal 
(see chapter "MiVoice Office 400 Self Service Portal", page 9).

If busy (CFB) Incoming calls are forwarded directly to a different desti-
nation if you are busy (Call Forwarding if Busy).

On no reply (CFNR) Additionally, incoming calls are forwarded to another 
destination. Both your own phone and the other destina-
tion will then start ringing. The system configuration 
determines whether or not the phone at the other desti-
nation rings with delay. Whoever goes off-hook first, 
answers the call. Depending on the system configura-
tion, Call Forwarding on No Reply can also be activated 
when your phone is busy.
Existing call forwarding settings at the selected destina-
tion cannot be executed. Contact your system adminis-
trator for more information.

Menu Description

User Incoming calls are forwarded to an internal user or a call 
number.

Voice Mail Incoming calls are forwarded to your voice mail, provid-
ing it has been set up by your system administrator.
You can use the global greeting or your personal greet-
ing (see chapter "Configuring voice mail", page 83). For 
further information on voice mail, please see the user's 
guide “User Guide Voice Mail Systems” on Mitel 
DocFinder.

Menu Description

Activating call forwarding to a call number or to a voice mail:
Press the function key for Menu.

Scroll to Call forwarding and press the navigation key to the right or press the 
Select softkey.

Select the call forwarding option you want and confirm with the Select softkey.
➔The call forwarding is activated.

Deactivate call forwarding:
Press the function key for Menu.
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Operating call lists and voice messages

In this section, you will learn how to use call lists and voice mes-
sages which are stored in the MiVoice Office 400 communication sys-
tem.

Editing options for the call list
The call lists (unanswered/answered calls and redial list) include a maxi-
mum of 30 entries each. Once the list is full, the oldest entry on the list will 
be deleted.

Missed calls are signaled on the display. The following options are avail-
able for further editing of the entries:

The call lists can be operated via the call lists key, the system menu or a 
function key, or via the redial key (see "Configuring keys", page 87).

More information on call lists can be found in chapter "Selecting from the 
call list", page 31.

Scroll to Call forwarding and press the navigation key to the right or press the 
Select softkey.

Select the option Call forwarding off and confirm with the Select softkey.
➔The call forwarding is deactivated.

Menu Description

Delete all Deleting all entries from a specific call list.

Detail Available detailed information:

• Call number / name

• Call date and time

• Number of call attempts

• Presence status of the user

Delete Delete entry.

Note: If you delete an entry in the unanswered calls list, then 
any voice messages for this entry are also deleted.

Dial Calling a user back.
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Editing options for voice messages
Your display shows the envelope symbol and the number of new voice 
messages. The message LED flashes red slowly.

The following options are available for further editing of the voice mes-
sages:

Options in the call list:
Mitel 6863 SIP: Press the function key for Menu. Scroll to Call list and press the 
navigation key to the right.
Mitel 6865 SIP: Press the call list key.

1. Scroll to the call list you want and press the Enter softkey.

2. Scroll through the list until the user you want is displayed.

Calling a user from the call list:
Pick up the handset.
➔The call number of the user is dialed. Once the call has been successfully 

connected, the user is deleted from the unanswered call list.

Calling up detailed information on an entry:

1. Select the entry you want and press the Enter softkey.

2. Call up detailed information using the softkey Detail > Enter.

Deleting an entry from the call list:

1. Select the entry you want and press the Enter softkey.

2. Delete entry using the softkey Delete > Enter.

Deleting all entries from the call list:

1. Select an entry and press the Enter softkey.

2. Delete all entries using the softkey Delete all > Enter.

Menu Description

Delete all Deleting all voice messages.

Detail Available detailed information:

• Call number / name

• Call date and time

Delete Delete voice message

Dial Call the person who left the voice message.
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Notes: • Depending on the system configuration your system administrator can 
specify that you are notified by e-mail whenever you receive a new 
voice message (with the voice message attached). Contact your system 
administrator for more information.

• To find out how to configure a voice mail, refer to chapter "Configuring 
voice mail", page 83 or the user guide “User Guide Voice Mail Systems” 
on the Mitel DocFinder.

• Voice messages to another voice mailbox that you are entitled to 
access are listed in the same voice mailbox as your own. You have the 
same editing options.1)

Voice messages can be managed through the system menu, a function 
key (see chapter "Configuring keys", page 87), or the Self Service Portal 
(see chapter "MiVoice Office 400 Self Service Portal", page 9).

Forward Forward the voice message to another user. You can 
decide whether to keep a copy of each voice message. A 
forwarded voice message is indicated by an additional 
letter which is the first letter of the softkey.

Play Play voice message.

Menu Description

1) from MiVoice Office 400 communication server software version R4.0 SP1 
onwards

Press the function key for Menu.

Scroll to Voice mail and press the right navigation key.
➔The list of received voice messages is displayed.

Play voice message:

1. Select the entry you want and press the Enter softkey.

2. Play the entry using the softkey Play > Enter.

Calling up detailed information on a voice message:

1. Select the entry you want and press the Enter softkey.

2. Call up detailed information using the softkey Detail > Enter.
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Organization within the team (busy lamp 
field, Mitel 6865 SIP only)

This section explains the different options provided by your phone to 
communicate in a team.

Using the busy lamp field key
You and your team partners want to be reachable at all times as a team 
and be able to communicate with one another as quickly as possible.

By pressing a single key you can call a team partner or answer a call for 
anyone in the team. When a team partner makes a call, the LED for the 
corresponding busy lamp field key lights up. This tells you when a team 
partner is busy. The busy lamp field key LED flashes to indicate that the 
team partner is receiving a call.

To be able to use the busy lamp field key, it must have been configured as 
such with the call number of the team partner, either by your system 
administrator or by yourself in the Self Service Portal (see chapter "Config-
uring keys", page 87).

The busy lamp field keys on the phone have two states:

• Line state: Line state shows the various states of the line, such as, idle, 
ringing, and busy. This is indicated by the LED on the phone.

• Presence state: It shows the presence state of the user such as avail-
able, absent, in a meeting, busy, or not available. The presence state is 
set by the team partner manually. This is indicated by the small circle on 

Deleting a voice message:

1. Select the entry you want and press the Enter softkey.

2. Delete entry using the softkey Delete > Enter.

Forwarding voice messages:

1. Select the entry you want and press the Enter softkey.

2. Press the softkeys Forward > Enter.

3. Enter the number you want and press the Enter softkey.

4. If you wish to keep a copy of this voice message, confirm this question by 
pressing the softkey End > Yes > Enter.
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the right side of the key on the phone.The green circle indicates the 
team partner as available, grey as absent, yellow as in a meeting, red 
as busy, and black as not available. 

Answering a call for a team partner
Your team partner is called. The LED on the busy lamp field key flashes. 
You know that your team partner is not at his desk at present and therefore 
decide to answer the call.

You take over the call by pressing the busy lamp field key. As soon as you 
have answered the call, your team partner is free again.

Line keys on the key telephone 
(Mitel 6865 SIP only)

This section explains the different options provided by your phone 
when your system administrator has assigned one of more configu-
rable keys as KT line keys. KT line keys make your phone a key tele-
phone.

KT lines are the external line keys. A KT line is associated with a call distri-
bution element (CDE) number. External user can reach you on the KT line 
using the Direct Dial In (DDI) number associated with the KT line. Contact 
your system administrator for more information. One or usually multiple 
phones can be connected to the KT line, for example, all employees in a 
travel agency who work with Europe as a destination. The KT line key 
belonging to the KT line shows the status of the KT line through the LED 
and allows you to accept calls which are made to this KT line. When there 
is an incoming call on a KT line of a phone while the phone is engaged in 
another call, an audio alert notifies you of the incoming call. 

Answering a call for a team partner:
Pick up the handset as long as the busy lamp field key LED is flashing.
➔You hear the dialing tone.

Press the busy lamp field key.
➔You are connected with the person who is calling your team partner.
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Your phone becomes a key telephone as soon as your system administra-
tor has assigned a KT line to a configurable key. With the configuration of a 
KT line key, your system administrator can also set up a personal line on 
which you can make your personal calls. All other function keys retain their 
function.

You can make some changes in the KT line configurations through Self 
Service Portal. You can activate the call list option and can give a name for 
the KT line. You can also assign up to 15 ring melodies.

KT lines can only be configured for function keys H1-H2/P1-P8.

KT lines can only be configured on the top softkeys and the keys of the 
expansion key module.

Note: Your system administrator can configure up to nine line keys (including 
personal and KT lines) for you, but you cannot have more than two simul-
taneous connections.

Answering a call on the KT line key
You are being called on one or more KT line keys. The KT line key(s) flash 
quickly. You want to answer a call on a KT line key.

If you want to answer a call on another KT line key first, press this KT line 
key in order to pick up the call. If you pick up the handset without pressing 
a KT line key, you will be connected to the highest priority KT line.

Note: If an incoming call meets a busy KT line, the call is forwarded to the other 
available KT line. Only if no more KT lines are free, your caller hears a 
busy tone.

Pick up the handset.
➔Connection to the KT line with the highest priority.
Or:
1. Press KT line key.
➔KT line is selected.
2. Pick up the handset.
➔Connection to the selected KT line.
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Initiating a call through a KT line key
You want to make a call through a KT line key.

You can call through any free KT line key. Each KT line is associated with 
a call distribution element (CDE) number. This means that, by phoning, 
you transmit the call number associated with the active KT line key.

Charges are accrued separately for each KT line key.

Using functions with Mitel OpenCount 

Mitel OpenCount is a software package for call logging management 
in communication systems and offers a clear overview over all cost 
structures. The application can be integrated into your MiVoice 
Office 400 communication system and enables the logging, the 
administration, and the analysis of all call and connection data.

If a Mitel OpenCount is integrated into your MiVoice Office 400 com-
munication system, the following additional feature is also available 
on your phone.

Activating PIN telephony
The PIN telephone service is part of Mitel OpenCount. The possible appli-
cations of the PIN telephony depend on the area of use, for example in the 
area of health care and accommodation/hotel:

• Independently from the phone you can make external calls for a fee. 
The credit may be limited.

• You can charge the charges and the call information of your outgoing 
and incoming calls to specific projects.

Enter the phone number.

Press a free KT line key.
➔The LED on the KT line key lights up. KT line is selected.

Pick up the handset.
➔The phone number is dialed.
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You must save this function to a configurable key using Self Service Portal 
(see chapter "Configuring or deleting a key assignment", page 88).

For further information, please see the product-specific user guides for 
Mitel OpenCount on our website (www.mitel.com) or contact your system 
administrator.

Setting functions by remote control

This section explains how you can alter your phone’s settings even if 
you are not directly at your phone.

You are not at your desk and want to set various functions on your phone 
from a different phone.

You can activate/deactivate many of your phone's functions by remote 
control from a different phone.

The remote control is initiated using a special function code. You must 
then enter the function commands and function codes (see chapter "Over-
view of available functions", page 56).

Activating/deactivating PIN call:
Press the function key for PIN call / PIN call rebook.
➔The function is activated/deactivated. The LED on the function key is 

switched on/off (Mitel 6865 SIP only).

Using remote control from a third-party phone:

1. Enter function code #06.

2. Enter your phone number.

3. Enter your PIN.

4. Enter the function code for activating/deactivating the function you want.

Pick up the handset.
➔You hear the acknowledgement tone.

Put the handset on-hook.
➔The function is activated/deactivated.

Note: The default PIN setting ‘0000’ is not accepted (for more information on the PIN, 
see chapter "Changing the PIN", page 80).
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Personalizing your phone

These sections explain how to adapt the phone’s basic settings to 
suit your personal requirements.

Configuring the display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  74

Configuring the audio properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  75

Configuring general phone settings  . . . . . . . . . . . . . . . . . . . . . . . . . . .  78

Protecting yourself against calls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81

Phone book management. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  82

Configuring voice mail. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83

Configuring presence profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85

Configuring keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87
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Configuring the display

This section explains how to set display properties.

Setting the display
You may find the display is too bright or too dark.

Display Description

Contrast level Setting the display contrast.

Backlight Setting the backlight (Mitel 6865 SIP only):

• Off The backlight is always deactivated.

• Auto The backlight is switched on automatically when the 
phone is used and switched off automatically when the 
phone has been idle for 30 seconds.

Press the Option key.

Scroll to Preferences and press the navigation key to the right.

Scroll to Display and press the navigation key to the right.

Setting the contrast:

1. Scroll to Contrast level and press the navigation key to the right.

2. Set the desired contrast using the horizontal navigation key and confirm with 
the Select softkey.

Setting the backlight:

1. Scroll to Backlight and press the navigation key to the right.

2. Select the required setting and confirm with the navigation key to the right.
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Configuring the audio properties

This section explains how to set audio properties.

Adjusting the volume
You want to change the volume of the ring tone or the handset during a 
call.

Ring volume: You can adjust the volume in the idle state or when the ring 
tone sounds. Press and hold the volume down button to switch off the ring 
tone completely.

Handset volume: You need to set the volume of handset and loudspeaker 
separately. The new handset volume will remain saved even after the call 
is ended.

Setting the ringing properties
You want to change the way in which your phone rings.

Available settings:

Adjusting the volume (in idle state, during ringing phase/call):
Quieter: Press the  key.
Louder: Press the  key.

Ring tones Description

Ring tones

• Ring tone 1...15 Selection of available ring melodies.

• Silent If you do not want to be disturbed during a certain time, 
you can set your phone not to ring with Suppress ring 
tone.

Tone set Country-specific ring tone settings. This menu is set by 
your system administrator.
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Note: • A list of alarm melodies is available for playback: Menu > Alarm melo-
dies > Test.

• You can configure individual ring tones for each busy lamp field and line 
key using the Self Service Portal (only Mitel 6865 SIP). For more infor-
mation about the Self Service Portal, please refer to "MiVoice 
Office 400 Self Service Portal", page 9.

Setting the audio properties
Using your phone, you can make and answer calls using the handset, 
headset or hands-free system.You can set custom ring melodies for your 
phone. The audio settings allow the use of different combinations of these 
three operation modes in order to achieve maximum flexibility in phone 
operation. The following options are available for selection:

Setting the ring:
Press the Option key.

Scroll to Preferences and press the navigation key to the right.

Scroll to Tones and press the navigation key to the right.

Scroll to Tones and press the navigation key to the right.

Select the setting you want and confirm with the Set softkey.
➔After you selected a ring melody, the melody will be played.

Audio settings Description

Audio Mode1): Setting possibilities:

• Speaker
(default)

The connection is established via the handset or the 
hands-free system.

• Press the loudspeaker/headset key when in handset 
mode to switch to hands-free mode.

• Pick up the handset when in hands-free mode to 
switch to handset mode.
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Notes: • To find out how to make phone calls with the headset, refer to "Using a 
headset (Mitel 6865 SIP only)", page 28.

• More information on the function Automatic hands-free can be found in 
chapter "Using your phone in hands-free mode", page 27.

• Headset The connection is established via the handset or the 
headset.

• Press the loudspeaker/headset key when in handset 
mode to switch to headset mode.

• Pick up the handset when in headset mode to switch 
to handset mode.

• Speaker/Headset At first, incoming calls are connected in hands-free 
mode by pressing the loudspeaker/headset key. 

• Press the loudspeaker/headset key repeatedly to 
switch back and forth between hands-free mode and 
headset.

• Pick up the handset to return the conversation from 
hands-free mode or headset to the handset at any 
time.

• Headset/Speaker At first, incoming calls are connected in headset mode 
by pressing the loudspeaker/headset key.

• Press the loudspeaker/headset key repeatedly to 
switch back and forth between headset mode and 
hands-free mode.

• Pick up the handset to return the conversation from 
hands-free mode or headset to the handset at any 
time.

Headset Mic Vol Sets the volume of the headset microphone.

DHSG Activate/deactivate DHSG.
Phoning using a cordless headset based on the DHSG 
standard allows you to set up and to end calls from the 
headset. Ask your dealer which headsets are particularly 
well suited for this phone.
To avoid damages on the phone always disconnect the 
phone from the mains power first before you install a 
DHSG headset.

1) All setting possibilities for the headset only apply to the Mitel 6865 SIP.

Audio settings Description
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Configuring general phone settings

This section explains other settings you can make on your phone.

Selecting the language
You wish to select a different user language for your display. 

To change both the local user language and the user language of the 
MiVoice Office 400 communication system, configure the language set-
tings for your phone over the Self Service Portal only. For more information 
about the Self Service Portal, please refer to "MiVoice Office 400 Self Ser-
vice Portal", page 9.

The language selection depends on the language packages your system 
administrator installed on your phone. English is the default language and 
is included in every language package. Should your desired language not 
be available, your system administrator can install more language pack-
ages.

If your desired language is available, but is not displayed or displayed only 
in parts, you have to restart your phone (see chapter "Restart phone", 
page 81).

Press the Option key.

Scroll to Preferences and press the navigation key to the right.

Scroll to Set Audio and press the navigation key to the right.

Setting the audio mode:

1. Scroll to Audio Mode and press the navigation key to the right.

2. Select the setting you want and confirm with the Set softkey.

Setting the headset volume (Mitel 6865 SIP only):

1. Scroll to Headset Mic Vol and press the navigation key to the right.

2. Select the setting you want and confirm with the Set softkey.
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Selecting the time and date
The settings for the time and date are made by your system administrator. 
The following chapter is thus intended for your system administrator or 
technician, who will then set the time and date for you.

As system administrator or technician, you can make global settings for 
the time and date for all Mitel SIP phones in the MiVoice Office 400 com-
munication system. If no NTP time server is entered in the communication 
system, then you can also make these settings over the phone. Available 
settings:

Using Live Dialpad (single-digit dialing)
Activates or deactivates the Live Dialpad. This local function is not sup-
ported by the MiVoice Office 400 communication system.

Setting Description

Time format 12-hour or 24-hour clock format.

Daylight savings List of available summer time formats.

Date format List of available global time zones.

Time zone List of available global time zones.

Time server 1-3 Setting menu for the IP address or domain name of the 
time server. If a valid time server is set, then the phone 
synchronises the displayed time with the specified con-
figuration server. The phone adopts the time from time 
server 1. If this is not configured or cannot be reached, 
then the phone queries first time server 2 and then 3.

Press the Option key.

Scroll to Preferences and press the navigation key to the right.

Scroll to Time/date and press the navigation key to the right.

Scroll to the setting you want and press the navigation key to the right.

Select the setting you want and confirm with the Set softkey.
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Changing the PIN
You want to change the PIN used to lock/unlock your phone and to thus 
protect your phone settings (more information about locking/unlocking 
your phone can be found in chapter "Locking/Unlocking your phone", 
page 52).

The digit combination "0000" is set as default. You can select any 2 to 8-
digit combination for your new PIN. The PIN on your phone is changed 
using the Self Service Portal only. For more information about the Self Ser-
vice Portal, please refer to "MiVoice Office 400 Self Service Portal", 
page 9.

Notes: • The PIN that you have changed locally on your phone cannot be dis-
played or overwritten over the Self Service Portal. Therefore, only con-
figure your PIN via the Self Service Portal of the MiVoice Office 400 
communication server.

• Please note that your personal PIN is valid for all your phones in the 
one number user concept (see chapter "One number user concept", 
page 8).

Enter the display text for the idle state
You want to change the text displayed by your phone in the idle state.

The display text shown in the idle state on your phone is configured using 
the Self Service Portal. For more information about the Self Service Portal, 
please refer to "MiVoice Office 400 Self Service Portal", page 9.

Local IP settings
Your phone saves phone-specific data such as IP address or memory 
space. The input of this data is password-protected; it can therefore only 
be carried out by your system administrator. You can however call up the 
data.

Calling up the phone status:
Press the Option key.

Scroll to Phone status and press the navigation key to the right.
➔Settings are displayed.
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Restart phone
You want to restart your phone. You have to restart your phone after the 
following actions:

• Installing a new language package. 

• Updating the newly selected language.

• Installing new phone software.

• Confirming new settings.

Notes: • Do not disconnect the power supply for the phone while the phone is 
being restarted.

• Every time you disconnect the power supply or restart the phone, the 
phone will test if the configuration changed or if a language or firmware 
update is available. If yes, you phone will update automatically, which 
may take a few minutes. Do not disconnect the power supply for your 
phone while this update is carried out.

Protecting yourself against calls

The protection function helps to protect yourself against other users 
applying telephony features on you via menu guidance or using func-
tion codes.

Calling up the system menu:
Press the function key for Menu.

Scroll to Software Version and press the navigation key to the right.
➔Settings are displayed.

Press the Option key.

Scroll to Restart phone and press the navigation key to the right.
Confirm the security question with Yes.
➔The phone is restarted.
Mitel 6863 SIP / Mitel 6865 SIP 81
eud-1663/2.0 – R6.0 – 06.2018



 Personalizing your phone
Activating protection against call types
You want to protect yourself against certain types of call. You can protect 
yourself from the following types of call:

• Call waiting1)

• Intrusion

• Call forwarding

• Announcement

• Fast take

• Remote control

Protection for these call types is configured using the Self Service Portal. 
For more information about the Self Service Portal, please refer to 
"MiVoice Office 400 Self Service Portal", page 9.

Phone book management

This section includes important information on your phone books.

Selection
If your phone is connected to an MiVoice Office 400 communications sys-
tem, then the following phone books can be selected:

System phone book

The system phone book contains the contacts of the users on the MiVoice 
Office 400 communication system and your private contacts, to which only 
you have access. It is integrated into the MiVoice Office 400 communica-
tion system by your system administrator.

With the help of quickdial and dialing by name in the system phone book 
(see chapter "Dialing from the phone book (directory lookup)", page 29), 
you can search for and call both a contact in the MiVoice Office 400 com-
munication system and in your private phone book.

Local phone book:

Aside from the system phone book, your phone also has a local phone 
book. This can be assigned to a function key.

1) Your system administrator can set the MiVoice Office 400 communication 
system to ignoring this call waiting block.
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The local phone book is not supported by the MiVoice Office 400 commu-
nication system. This implies that contacts saved in this local phone book 
are only available on your Mitel SIP phone. The search function in the sys-
tem phone book (quickdial and dialing by name) does not search in the 
local phone book.

Note: In the option menu (option key > Phone book), you can change the desired 
order of names and sorting.

Private contacts:

We recommend using the following products to manage your private con-
tacts:

• Self Service Portal (see chapter "MiVoice Office 400 Self Service Por-
tal", page 9).

• Mitel OfficeSuite

• External directories, such as Microsoft Exchange (provided your 
MiVoice Office 400 communication system is synchronised with exter-
nal directories).

Configuring voice mail

This section explains how to set your voice mail.

Managing personal voice mail greeting
Depending on the system configuration, you have the option of recording 
up to 3 different greetings (e.g. for absences or holidays). Give each greet-
ing an appropriate name. Depending on the system configuration a caller 
may or may not be able to leave a message.

If no personal greeting is activated or if none is available, the global greet-
ing is activated automatically, provided it has been recorded. For further 
information on voice mail, refer to your system administrator or the user's 
guide User Guide Voice Mail Systems on the Mitel DocFinder.

The following options are available for further editing of your voice mail 
greetings:

Menu Description

Record Record voice mail greeting.

Select Activating the voice mail greeting.

Edit Renaming the voice mail greeting.
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Operation of voice mail is available via the system menu, a function key 
(see chapter "Configuring keys", page 87), or the Self Service Portal (see 
chapter "MiVoice Office 400 Self Service Portal", page 9).

To know more about options for editing voice messages, see chapter "Edit-
ing options for voice messages", page 66.

Mode: Selecting the mode:

• Recording allowed Caller can leave a message.

• Recording not 
allowed

Caller cannot leave a message.

Play Play voice mail greeting

Menu Description

Press the function key for Menu.

Scroll to Voice Mail and press the Enter softkey.

Select any entry and press the Enter softkey.

Scroll to Settings and press the Enter softkey.

Renaming the voice mail greeting:

1. Select the greeting you want and press the Enter softkey.

2. Press the Edit > Enter softkeys.

3. Enter the name and confirm with the Enter softkey.

Recording voice mail greeting:

1. Select the greeting you want and press the Enter softkey.

2. Press the softkey Record > Enter.

3. Pick up the handset and record your own personal greeting.

4. Stop the recording using the Done softkey.

Playing voice mail greeting:

1. Select the greeting you want and press the Enter softkey.

2. Press the Play > Enter softkey.

3. You can monitor your personal greeting text and re-record it if necessary.
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Configuring presence profile

You want to manage your incoming calls taking your current presence sta-
tus into account (see chapter "Organizing absences from the desk", 
page 61).

You have a choice of 5 presence profiles for managing your presence sta-
tus: Available, Absent, Meeting, Busy, Not available. Presence profiles 
contain action commands that are executed when the presence status is 
activated. This may be a call forwarding to a voice mail and/or a pre-
defined personal call routing.

For each of these presence profiles you can make the following settings:

Selecting the mode:

1. Select the greeting you want and press the Enter softkey.

2. Press the Mode > Enter softkey.

3. Select the mode you want and confirm with the Enter softkey.

Activating the voice mail greeting:

1. Select the greeting you want and press the Enter softkey.

2. Confirm with the Select > Enter softkey.

Menu Description

Description Type in the text to be displayed to other users as detailed 
information for your presence status (e.g.: “Meeting until 
4 pm.”). You can also leave this input field blank.

Time/date Enter the time and/or date of your absence: This infor-
mation is displayed to your caller, providing you selected 
the Absence information setting for call forwarding to 
voice mail. You can also leave this input field blank.

Personal call routing: Specify the phones on which a call is to be signaled (see 
"Activating personal call routing", page 50).

• Keep settings as is Calls are routed according to your settings.

• None Any set call forwarding operation is deleted.

• Routing ID <1...5> Your personal call routing number.

Call forwarding: Specify the phones on which a call is to be signaled (see 
"Call forwarding", page 63).

• Keep settings as is Calls are routed according to your settings.

• Forwarding off Any configured call forwarding operation is deleted.
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Presence settings can be managed via the system menu, a function key 
(see chapter "Configuring keys", page 87), or the Self Service Portal (see 
chapter "MiVoice Office 400 Self Service Portal", page 9).

Note: In the Self Service Portal, you can specify whether you 
want the same or a different forwarding destination for 
external and internal calls. The call number of the exter-
nal call forwarding destination is then always shown on 
your phone display unless the external forwarding desti-
nation is No forwarding.

• User A call is channelled to the defined forwarding destina-
tion.

• Voice Mail A call is forwarded to voice mail. The greeting to be 
played can be configured with voice mail greeting.

Voice mail greeting: Activate the greeting you want.

• Keep settings as is Your currently defined greeting is used.

• Absence informationYour caller is given an absence information (as well as 
time and date, if this has been configured as such in the 
presence profile). This setting is not available in the 
Available presence profile. More information can be 
found under "Absence information", page 62.

• Default greeting Your caller will hear the global greeting (name depends 
on the MiVoice Office 400 communication system).

• Personal greeting • If you renamed your personal greeting, your greeting 
name is displayed here. Your caller obtains one of the 
currently active personal greetings.

• The time and date are never played in the global 
greeting and personal greetings.

Menu Description

Changing the presence profile:
Press the function key for Menu.

Scroll to Presence and press the Enter softkey.

Select the presence profile you want and press the Enter softkey.

Press the Modify > Enter softkey.
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Configuring keys

This section explains how to assign call numbers, functions and 
busy lamp fields to a key.

Available keys
You can assign the configurable keys of your phone with a specific action 
type so you can trigger a particular action by simply pressing that key. The 
following choice is available:

Select the setting you want and press the Enter softkey.

Make the changes and confirm with the Enter softkey.

Action type Designation Description

Call number Number key Configure a key with a call number and name

Function Function key Configure a key with a function in order to run 
or activate/deactivate a function.

Busy lamp field1)Team key2) Configure a key with your team partner's call 
numbers.

KT line Line key A line key has a call number which can be used 
for internal or external calls. In general, multi-
ple phones can be connected to this line. Your 
phone becomes a key telephone as soon as 
your system administrator has assigned a KT 
line to a configurable key.
KT lines are only possible on function keys H1 
to H2 (Mitel 6863 SIP) or H1 to H2/P1 to P8 
(Mitel 6865 SIP). For more information on KT 
line keys, please refer to "Line keys on the key 
telephone (Mitel 6865 SIP only)", page 69.

Personal line Personal call 
key

Personal line on key telephones and operator 
phones on which you can make personal calls. 
The personal line is created automatically as 
soon as your system administrator has 
assigned a key on your phone as a KT line or 
operator.

Note: Your phone can be either a key telephone or an operator 
phone.
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Configuring or deleting a key assignment
You want to configure a configurable key with a call number, function or 
busy lamp field, or you want to delete the key configuration.

The keys must have been configured either by your system administrator 
or by yourself in the Self Service Portal (see chapter "MiVoice 
Office 400 Self Service Portal", page 9). An overview of the available func-
tions can be found in the chapter "Overview of available functions", 
page 56.

Note: A key that you have configured locally on your phone cannot be displayed 
or overwritten over the Self Service Portal. Therefore, always configure 
your keys via the Self Service Portal of the MiVoice Office 400 communica-
tion server.

1) Mitel 6865 SIP only

2) The audio features of a busy lamp field can be configured in the Self Service 
Portal (see chapter "MiVoice Office 400 Self Service Portal", page 9).
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Product and safety information

The product and safety information is available here. You will also 
find notes on data protection. Please read this information carefully.

Safety information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Product information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Data protection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  91
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Safety information

The safety information can be found in chapter "Safety information", 
page 4.

Product information

Purpose and function
This product is part of the MiVoice Office 400 communication solution.

MiVoice Office 400 is an open, modular and comprehensive communica-
tion solution for the business sector with several communication servers of 
different performance and expansion capacity, an extensive telephone 
portfolio and a multitude of expansions. They include an application server 
for unified communications and multimedia services, an FMC controller for 
mobile phone integration, an open interface for application developers, 
and a multitude of expansion cards and modules.

The business communication solution with all its components was devel-
oped to cover in full the communication requirements of businesses and 
organizations, in a way that is both user- and maintenance-friendly. The 
individual products and components are coordinated and must not be used 
for other purposes or replaced by third-party products or components 
(unless it is to connect other approved networks, applications and termi-
nals to the interfaces certified specially for that purpose).

User information
MiVoice Office 400 products are supplied with the necessary safety/legal 
information and user documents. All user documents such as user guides 
and system manuals are available for download from the MiVoice 
Office 400 document portal as individual documents or as documentation 
sets. Some user documents are accessible only via a partner login.

It is your responsibility as a specialist retailer to keep up to date with the 
scope of functions, the proper use and the operation of the MiVoice 
Office 400 communication solution and to inform and instruct your custom-
ers about all the user-related aspects of the installed system:

• Make sure you have all the user documents required to operate your 
product efficiently and correctly.
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• Make sure that the versions of the user documents comply with the soft-
ware level of the MiVoice Office 400 products used and that you have 
the latest editions.

• Always read the user documents first before you put your product into 
operation.

• Store the user information within easy reach and refer to it whenever 
uncertainties arise in connection with the use of the product.

• When handing over your product to others, make sure you enclose the 
relevant user information.

Data protection

Protection against listening in and recording
The MiVoice Office 400 communication solution comprises features which 
allow calls to be monitored and recorded without the call parties noticing. 
Please note that these features can only be used in compliance with 
national data protection provisions.

Download the MiVoice Office 400 documents from the internet: 
http://www.mitel.com/docfinder or from http://edocs.mitel.com
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